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Introduction 
 

 

Welcome to your Learner’s Guide for the Pine Nuts Processor Program. It will help you to complete the program and to go on to complete further 
study or go straight into employment. 

The Pine Nuts Processor program is to engage young people with a program of development that will provide them with the knowledge, skills and 
understanding to start this career in Pakistan. The program has been developed to address specific issues, such as the national, regional and local 
cultures, the manpower availability within the country, and meeting and exceeding the needs and expectations of their customers. 

The main elements of your learner’s guide are:  

• Introduction:  
o This includes a brief description of your guide and guidelines for you to use it effectively 

• Modules:  
o The modules form the sections in your learner’s guide  

• Learning Units:  
o Learning Units are the main sections within each module 

• Learning outcomes:  
o Learning outcomes of each learning units are taken from the curriculum document  

• Learning Elements:  
o This is the main content of your learner’s guide with detail of the knowledge and skills (practical activities, projects, assignments, 

practices etc.) you will require to achieve learning outcomes stated in the curriculum 
o This section will include examples, photographs and illustrations relating to each learning outcome 

• Summary of modules:  
o This contains the summary of the modules that make up your learner’s guide 

• Frequently asked questions:  
o These have been added to provide further explanation and clarity on some of the difficult concepts and areas. This further helps you 

in preparing for your assessment.  
• Multiple choice questions for self-test:  

o These are provided as an exercise at the end of your learner’s guide to help you in preparing for your assessment. 
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Module 4: Develop basic computer operating skills 
 

Objective of the Module: This module covers the skills and knowledge required to Operate MS word, Operate MS Excel, Operate MS Power Point, Perform      Browsing 
and Print Document. 

 

 

Learning Unit   
Learning Outcomes  Learning Elements  Duration  

Materials  

Required  

Learning  

Place  

LU1. Operate MS 
word 

Trainee will be able to: 

 Perform Microsoft basic 

commands in MS word  

 Open File 

 Format a file 

i. Font 

(Type/size/bold/Italic) 

ii. Header Footer 

iii. Page number 

iv. Insert pics / 

table/hyperlink 

 Save a File 

 Save a folder 

 Knowledge of Basic parts of 

computers 

 Importance and use of MS Word 

 Procedure to perform 

various functions in Home 

tab 

 

Theory- 06 Hrs. 

Practical- 33 Hrs. 

Total- 39 Hrs.  

 Computer 

 Windows CD 

 MS office CD 

 

Class Room 
and  

Computer lab 

LU2. Operate MS 
Excel   

Trainee will be able to: 

 Perform basic commands in 

Microsoft MS Excel 

 Open a worksheet. 

 Sum functions 

 If functions 

 Importance and uses of MS Excel 

 Procedure to perform various 

functions in Home tab 

 

Theory- 06 Hrs. 

Practical- 33 Hrs. 

      Total- 39 Hrs. 

 Computer 

 Windows CD 

 MS office CD 

 
Class Room 
and  

Computer lab 
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 Basic calculations 

 Table and graphs 

 Save a worksheet/folder 

LU3. Operate MS 
Power Point 

Trainee will be able to: 

 Prepare Microsoft power 

point presentation with basic 

commands 

 Make a power point file 

 Insert pics/table/hyperlink 

 Design a theme for slides 

 Save a power point file 

 Importance and use of MS Power 

Point 

 Procedure to develop 

presentation 

 

Theory- 06 Hrs. 

Practical- 30 Hrs. 

      Total- 36 Hrs. 

 Computer 

 Windows CD 

 MS office CD 

 
Class Room 
and  

Computer lab 

LU4. Perform 
Browsing 

Trainee will be able to: 

 Perform browsing on the 

internet as per needs  

 Perform search online on 

new trends in the market 

with the help of internet 

 Importance of Internet. 

 Use of various search engines like 

Google, YouTube etc. 
Theory- 04 Hrs. 

Practical- 30 Hrs. 

      Total- 34 Hrs. 

 Computer 

 Internet 

connection 
Class Room 
and Computer 
lab 

LU5. Print Document 

Trainee will be able to: 

 Select Printer  

 Select page setup  

 Print relevant pages 

 Printing Procedure and 

techniques. 

 

Theory- 03 Hrs. 

Practical- 09 Hrs. 

   Total- 12 Hrs. 

 Computer 

 Printing 

 papers 

 (A4 and Legal 

size) 

Class Room 
and  

Computer lab 
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Examples and Illustrations:  

 

Basic Parts of a Computer 

 

A. Input Devices:  

1. Keyboard 

2. Mouse 

3. Microphone 

 

 

B. Process: 

CPU Central Processing Unit 

 

 

C. Output Devices 

1. Monitor 

2. Printer 

3. Speaker 
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MS Word: 
Microsoft Word is a word processing program that was first made public by Microsoft in the early 1980s. It allows users to type and manipulate 
text in a graphic environment that resembles a page of paper. Extra features, such as tables, images and advanced formatting give users more 
options to customize their documents. Over the past three decades, there have been a number of updates and additions to Microsoft Word. 
Today it is one of the most widely used word processors available for Macs and PCs. It is often taught to students in schools and required as part 
of the basic computer requirements for many office jobs. Here you will learn the basic functions of Microsoft Word and how to use them. 

 

Alignment – The alignment options dictate whether the left and right edges of the text in a document adhere to the right side, left, center or 
justified. Alignment can be set from the formatting toolbar at the top of the window or under by choosing “Paragraph” under the Format menu. 

 

Bullets/Numbering – When creating a list of text items, users can choose from several bullet or numbering system to add a small graphic icon 
or series of numbers before each item. To add bullets or numbering to a series of text, click on the corresponding buttons in the formatting toolbar 
or choose “Bullets and Numbering” from the Format menu. 

 

Copy – Copying text simply means making a replica of any text that is currently selecting and saving it to the clipboard. Pressing the Control and 
C keys in Windows or Command and C on a Mac will copy the text. Alternatively, users can also select the text and then click the “Copy” option 
under the Edit menu or in the main toolbar. 

 

Cut – Cutting text removes the text entirely from the viewable document and stores it in the clipboard. Control-X or Command-X are the keyboard 
shortcuts for the Cut function on Windows and Mac respectively. The Cut function can also be found under the Edit menu or the toolbar. 

 

Document – Each document in Microsoft Word is essentially a new file. Each document can be several pages long. A new document can be 
created by hitting Control-N or Command-N, or by choosing the “New Blank Document” option from the File menu or the standard toolbar. 

 

Edit – The edit menu or toolbar in Microsoft Word allows users to perform basic editing functions in their document such as copying, cutting and 
pasting. It also contains options for the Undo and Find/Replace functions. 

 

Font – A font is a type of design for text and typically incorporates this design into each letter, number and symbol found on a keyboard. Fonts 
can range from formal to whimsical. Microsoft Word comes with a series of provided fonts and additional ones can also be downloaded if needed. 
To change the font used in a document, select the text and either click on the main Font menu, the Font drop-down menu in the formatting toolbar 
or hit Control-D or Command D. 

Footer – The footer is the text that consistently appears on every page of a document, at the bottom of each page. Footers normally include 
details such as the page number, or a company’s name and contact details in formal documents. Add or edit a footer by choosing “Header and 
Footer” under the View menu. 
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Format – The Format menu (or toolbar) goes one step further than the Edit menu. Users can make stylistic changes by changing the look of the 
text itself, paragraphs, lists and more. 

 

Header – The header is similar to a footer except that it sits at the very top of every page in a document. Headers often contain page numbers, 
the document name or sub-titles within a document. The header can be edited by clicking on “Header and Footer” within the View menu. 

 

Justify, left justified, right justified – Justification is a type of alignment for text in a word processor. Justify ensures that both the left and right 
sides of the text in every paragraph run in a straight line. Left justify makes only the left side of the text aligned, while the right side remains 
ragged. Right justified does the complete opposite, with only the right side of the text aligned. Users can apply justification to their text by clicking 
on the corresponding buttons in the formatting toolbar or by selecting the text and clicking on “Paragraph” under the Format menu. 

 

Open – The Open command opens an existing document in Microsoft Word. Command or Control plus O, or choosing “Open…” from the File 
menu will provide a pop-up window for users to select the document they wish to open. 

 

Paste – The paste command takes any previously copied or cut text and lays it down within the document where the cursor is pointing. Control 
or Command plus V, or “Paste” from the Edit menu or standard toolbar will run the paste function. 

 

Print – The print command first opens a window where users can specify parameters of the paper, printer and ink they wish to print with and it 
provides a preview of what the physical print will look like. Control or Command plus P, or clicking on “Print” in the File menu or standard toolbar 
lets users access the print window. 

 

Save – The save command is one of the most important ones. It saves all of the work done to date within a document. The save command 
enables users to return to the same document later and continue writing, editing or printing. Control or Command plus S, or clicking “Save” under 
the File menu or standard toolbar will save the document. The “Save As” option is slightly different; it allows users to save the document as a 
different version by adding a different file name. 

Undo – The undo feature keeps track of each command that a user issues while working on their document. Issuing the undo command allows 
the user to go back one step and restore the document as it was before their latest editing command. Related to the Undo command is Redo, 
which lets the user redo the same formatting command again. Control or Command plus Z, or “Undo” under the Edit menu is used to undo a 
command, while Control or Command plus Y or “Redo” under Edit is to redo a command. 
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Keyboard Shortcuts for Microsoft Word 

Shortcuts Keys Operation 

Ctrl+X Cut 

Ctrl+C Copy 

Ctrl+V Paste 

Ctrl+Z Undo 

Ctrl+Y Redo 

Ctrl+S Save 

Ctrl+P Print 

 

Shortcuts for moving around easily / quickly in Word 

Home Beginning of line 

End End of line 

Ctrl + Home Go to start of document 

Ctrl + End Go to end of document 

Right Arrow Right one character 

Left Arrow Left one character 

Ctrl+Right Arrow Right one word 

Ctrl+Left Arrow Left one word 
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Text Formatting Shortcuts in Word 

Ctrl+B Bold 

Ctrl+I Italics 

Ctrl+U Underline 

Ctrl+Shift+L Bulleted list 

Ctrl+L Align left 

Ctrl+R Align right 

Ctrl+E Align centre 
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MS Excel 

 

Microsoft Excel is a program that provides worksheets comprised of rows and columns. Data can be stored in the worksheet, also called a 
spreadsheet, similarly to a Microsoft Word table, but the power of Excel is its ability to perform simple to complex mathematical calculations, and 
other functions. An Excel worksheet, or spreadsheet, is a two-dimensional grid with columns and rows. 

 

What are Excel Formulas? 

Excel formulas help you identify relationships between values in the cells of your spreadsheet, perform mathematical calculations using those 
values, and return the resulting value in the cell of your choice. Formulas you can automatically perform include sum, subtraction, percentage, 
division, average, and even dates/times 

 

1. SUM   

All Excel formulas begin with the equals sign, =, followed by a specific text tag denoting the formula you'd like Excel to perform.  The SUM formula 
in Excel is one of the most basic formulas you can enter into a spreadsheet, allowing you to find the sum (or total) of two or more values. To 
perform the SUM formula, enter the values you'd like to add together using the format, =SUM (value 1, value 2, etc.). The values you enter into 
the SUM formula can either be actual numbers or equal to the number in a specific cell of your spreadsheet. 

You can also practice the Division, Multiplication, subtraction, Percentage etc.  

 

2. IF 

The IF formula in Excel is denoted =IF (logical test, value_if_true, value_if_false). This allows you to enter a text value into the cell "if" something 
else in your spreadsheet is true or false. For example, =IF(D2="Pass","10","0") would award 10 points to cell D2 if that cell contained the word 
"Gryffindor." 

There are times when we want to know how many times a value appears in our spreadsheets. But there are also those times when we want to 
find the cells that contain those values, and input specific data next to it. 

We'll go back to the example for this one. If we want to award 10 points to everyone who belongs in the Pass Group, instead of manually typing 
in 10's next to each Pass student's name, we'll use the IF-THEN formula to say: If the student is in Pass, then he or she should get ten points. 

The formula: IF(logical test, value_if_true, value_if_false) 

Logical Test: The logical test is the "IF" part of the statement. In this case, the logic is D2="Pass." Make sure your Logical Test value is in quotation 
marks. 

Value_if_True: If the value is true -- that is, if the student is Pass -- this value is the one that we want to be displayed. In this case, we want it to 
be the number 10, to indicate that the student was awarded the 10 points. Note: Only use quotation marks if you want the result to be text instead 
of a number. 

Value_if_False: If the value is false -- and the student does not Pass -- we want the cell to show "0," for 0 points. 
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Microsoft PowerPoint  

Microsoft PowerPoint is undoubtedly the most popular app used to give presentations. You're likely to see PowerPoint presentations used for 
everything from the world's largest companies to grade school teachers sharing lessons. 

Here are the key actions you'll need to take to build a PowerPoint presentation: 

You'll need to add slides, the individual pages in the presentation. 

You'll add content to the slides, such as text boxes, images, charts and graphs. 

Change themes and styles to make your presentation look professional and fit the occasion at hand. 

Prepare presentation aids like Speaker Notes and Presenter View to help you feel comfortable with presenting 

The Ribbon 

The ribbon menu is found across many of Microsoft's apps, such as Word, Excel, and PowerPoint. It lives above the main area of the application. 

 

 
 

 

 

 

The ribbon contains a series of tabs that you can switch between. Each of these have a unique set of tools to work with your presentation differently. When you 
switch tabs on the ribbon, you'll see new buttons and options to modify your presentation: 

 File. Save, share, and export your presentation. 

 Home. A general purpose collection of the most common tools that you'll use in PowerPoint. 

 Insert. An all-in-one tool to add every imagine-able type of content, such as tables, pictures, charts, video, and more. 

 Design. Controls the overall look and feel of your presentation with theme and style settings. 

 Transitions. Add animations when you switch slides. 

 Animations. Controls the order and style that objects will enter or exit your slide with. 

 Slide Show. Control settings related to the way your presentation appears when sharing it with an audience. 

Now that you understand the layout, you have a better idea of how you can jump to the feature you need. 
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Print a Document 

 

 Open the document or file you want to print. 

 In the top portion of the window of the program or browser you are using, the File menu is in the upper-left corner of the screen. 

 If you clicked File, select Print from the drop-down menu. 

 Either option opens a Print properties window or automatically starts printing the document or file. 

 If the Print properties window is showing, you can specify additional printing options, such as how many copies you want or which specific 

pages you want to print. Once you've selected the options, click Ok or Print to start the printing process. 
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Module 5: Develop Basic Communication Skills 

Objective: This module covers the skills and knowledge required to Adopt effective listening, Develop nonverbal communication, Develop verbal 

communication, Develop confidence and Pick the right medium.  

Learning Unit  Learning Outcomes  Learning Elements  Materials Required  

LU1. Adopt Effective 
Listening 

Trainee will be able to: 

 Practice active listening 

 Ask clarifying questions 

 Listen and sympathize with other 

person 

 Describe importance of active 

listening 

 Describe clarity of questioning 

 Explain importance of sympathizing a 

person 

 Multimedia 

 Stationery 

 Effective Listening 

Modules 

LU2. Develop Nonverbal 
Communication 

Trainee will be able to: 

 Adopt hand gestures if required  

 Encourage others to speak 

openly with you 

 Make eye contact with 

communicator 

 Make relaxed, open stance 

during communication  

 Perform friendly tone during 

communication 

 Explain importance of hand gestures 

 Describe importance of encouraging 

others to speak openly 

 Describe the importance of eye 

contact in communication 

 Describe the importance of open 

stance and relaxed communication 

 Explain the usefulness of friendly tone 

 Multimedia 

 Stationery 

 Non Verbal 
Communication 
Modules 

LU3. Develop verbal 
communication 

Trainee will be able to:  Explain face to face conversation 

 Explain importance of clarity in direct 

messaging 

 Multimedia 

 Stationery 

 Verbal 
Communication 
Modules 

https://www.thebalancecareers.com/active-listening-skills-with-examples-2059684
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698
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 Adopt face to face conversations 

 Convey your message clearly and 

directly 

 Adopt phrases as simple as 

possible 

 Respect others and their ideas 

 Describe use of simple phrases 

 Describe importance of individual 

respect and their ideas  

LU4. Develop Written 
Communication 
Skills 

 Trainee will be able to: 

 Convey your message in few 

words. 

  Convey message through live 

phone calls.   

  Convey message through 

Whatas.  

  Convey message through 

email. 

  Convey message through 

writing. 

 Describe self confidence in interaction 

with others 

 Describe usefulness of firm 

communication in friendly tone 

 Explain the importance of behavioral 

skills 

 Describe the usefulness of sound 

interpersonal skills 

 Define good understanding 

 Multimedia 

 Stationery 

 Written 
Communication skills  
Modules 
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Good Listening Skill: 

Listening is one of the most important skills you can have. How well you listen has a major impact on your job effectiveness, and on the quality 

of your relationships with others. 

For instance: 

 We listen to obtain information. 

 We listen to understand. 

 We listen for enjoyment. 

 We listen to learn. 

 

Becoming an Active Listener 

There are five key active listening techniques you can use to help you become a more effective listener: 

1. Pay Attention 

Give the speaker your undivided attention, and acknowledge the message. Recognize that non-verbal communication also. 

 Look at the speaker directly. 

 Put aside distracting thoughts. 

 Don't mentally prepare a rebuttal! 

 Avoid being distracted by environmental factors. For example, side conversations. 

 "Listen" to the speaker's body language. 
 

2. Show That You're Listening 

Use your own body language and gestures to show that you are engaged. 

 Nod occasionally. 

 Smile and use other facial expressions. 

 Make sure that your posture is open and interested. 

 Encourage the speaker to continue with small verbal comments like yes, and "uh huh." 
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3. Provide Feedback 

Our personal filters, assumptions, judgments, and beliefs can distort what we hear. As a listener, your role is to understand what is being said. 

This may require you to reflect on what is being said and to ask questions. 

Ask questions to clarify certain points. "What do you mean when you say...." "Is this what you mean?" Summarize the speaker's comments 

periodically. 

 

4. Defer Judgment 

Interrupting is a waste of time. It frustrates the speaker and limits full understanding of the message. Allow the speaker to finish each point before 

asking questions. Don't interrupt with counter arguments. 

 

5. Respond Appropriately 

Active listening is designed to encourage respect and understanding. You are gaining information and perspective. You add nothing by attacking 

the speaker or otherwise putting her down. 

 Be candid, open and honest in your response. 

 Assert your opinions respectfully. 

 Treat the other person in a way that you think s/he would want to be treated. 
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What is nonverbal communication? 

Nonverbal communication is the transfer of information through the use of body language including eye contact, facial expressions, gestures and 
more. Verbal communication is the use of language to transfer information through written text, speaking or sign language. 

Nonverbal communication is important because it gives us valuable information about a situation including how a person might be feeling, how 
someone receives information and how to approach a person or group of people. Paying attention to and developing the ability to read nonverbal 
communications is an invaluable skill you can leverage at every stage of your career. 

 

Types of nonverbal communication 

There are several types of nonverbal communications you should be aware of, including: 

Body language: Body language is the way someone situates their body naturally depending on the situation, the environment and how they are 
feeling. For example, someone might cross their arms if they are feeling angry or nervous. 

Gestures: While gestures vary widely across communities, they are generally used both intentionally and unintentionally to convey information to 
others. Someone in the United States might display a “thumbs up” to communicate confirmation or that they feel positively about something, for 
example. 

Facial expressions: One of the most common forms of nonverbal communication is facial expressions. Using the eyebrows, mouth, eyes and 
facial muscles to convey can be very effective when communicating both emotion and information. 

Touch: Some people also use touch as a form of communication. Most commonly, it is used to communicate support or comfort. This form of 
communication should be used sparingly and only when you know how the receiving party feels about touch. It should never be used to convey 
anger, frustration or any other negative emotions in the workplace. 
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Verbal Communication 

Strong verbal communication skills are important for everyone to master. They are extremely valuable in both your personal and professional life. 
When speaking clearly, confidently, and with poise, you are much more likely to command the respect of others and build rapport. This is 
particularly important in business interactions 

Nonverbal elements such as posture, gestures, and facial expressions are also important factors in developing good verbal communication skills. 
Ultimately, good speakers should make frequent eye contact with the audience, let their facial expression show their interest in the ideas they 
are presenting, dress in a way that is appropriate for the occasion and keep their energy levels high. 

Here are the reasons why Oral Communication is great 

 It saves time, 

 It is more effective as emotions are well portrayed, 

 The feedback loop is faster, 

 Verbal communication is economical, 

 The tone is easy to read  

 

Factors of Effective Verbal communication: 

1. Think before you speak  

By organizing your thoughts in advance, you can eliminate many of the awkward pauses that occur when speaking. It will also help you relay 
your information more concisely. 

While writing down your thoughts is not always possible in spontaneous discussions, it is still effective to take a minute to organize your thoughts 
in your mind before you begin to speak. 

 

2. Speak with confidence  

Speaking in a confident manner will help you build trust and command the respect of your audience. There are several factors which can impact 
your ability to speak confidently, including your command of the subject matter, your word choice, the tone of your voice, your body language, 
and your ability to make direct eye contact with your audience. 

3. Be clear and concise  

The most effective way to get your point across is to make it in a clear and concise manner. Avoid using complex, convoluted sentences, and try 
to state your argument in direct language. Before speaking, ask yourself, “What is the clearest way I can make my point?” 

 

4. Be aware of your non-verbal communication cues  
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Your body language significantly impacts the way others interpret what you say. Pay attention to the gestures you make, your facial expressions, 

and your body language to ensure they align with the message you are trying to get across. 

 

5. Be a good listener 

Being a good listener is as important as being a good speaker, and it will improve the quality of your verbal interactions. It shows the people you 

are speaking with that you genuinely care about their ideas, and it helps ensure you understand their needs. This will enable you to build trust 

and rapport much quicker. 

 

6. Think about the perspective of your audience  

Just because you have a strong command of a topic doesn’t mean the people you are speaking to have the same knowledge as you. 

Try to think about how someone else will understand what you are trying to communicate, particularly if they lack the technical knowledge about 

a subject that you possess. 

 

7. Vary your vocal tone  

Speaking in a monotone voice is a surefire way to bore your audience. Instead, use voice inflection to add emphasis to important points, and 

vary the pitch of your voice to express emotion. This will help keep your audience engaged in your message. 

 

Effective verbal communication is an important skill to understand. Having the courage and ability to convey your thoughts in a respectable way 

will help enhance mutual understanding, trust, decision-making, and problem-solving between yourself and others, making the act of properly 

speaking and listening to an imperative influence on how we learn and think for ourselves. 
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Written Communication Skills: 

Written communication skills can be useful, even crucial, for career success. If you're good at business writing, you're more likely to create a 

good impression. But if you aren't getting the message across clearly with your words, your chances for getting jobs, promotions, raises and 

bonuses may be harmed. 

Whether you’re sending a winning cover letter to a hiring manager, a memo to a colleague, a report to your team or an email to a client, crisp, 

highly focused and error-free writing signals that you’re someone who is organized, knowledgeable and detail oriented. 

Conversely, written communications that are long-winded, imprecise or strewn with typos leave readers wondering how you handle other aspects 

of your job. If your business writing abilities are a weakness, the time to improve is now. 

How to Make Your Writing Communicate? 

Effective writing allows the reader to thoroughly understand everything you are saying. This is not always easy to do. Here are a few tips that will 

help you: 

1. Know your goal and state it clearly. Do you want the reader to do something for you or are you merely passing along information? Do 

you want a response from the reader or do you want him to take action? Your purpose needs to be stated in the communication. Avoid 

information that is not relevant. Clarity is key. 

2. Tone can help your writing be more effective. Certain forms of communication, like memorandums and proposals need a formal tone. 

Writing to someone you know well would need a more informal tone. The kind of tone depends on the audience and purpose of the 

writing. 

3. Explain in clear terms what you want the reader to do. They cannot oblige if they do not understand. Also, they may not even want to try 

to help if the communication is vague and sloppily written. It is good to include why it is beneficial to them to do what you ask or to help 

you. 

4. Language needs to be simple. Do not overuse clichés, jargon, and expressions or try to impress with big words. Keep sentences and 

paragraphs short and concise. 

5. Less is more when it comes to length. Leave out words that do not contribute to the main focus of the communication. This can make 

the reader work harder to know why you wrote. 

6. Using an active voice will strengthen your writing. Sentences that are written in the active voice will flow better and are easier to 

understand. Long, complicated sentences will slow the reader down, even more so if they are written in the passive voice. An active 

example is "I caught the ball." and a passive example is "The ball was caught by me." Active voice will engage the reader and keep his 

attention. 

7. Good grammar and punctuation are very important. It is a good idea to have someone else proofread your writing before you send it. If 

you cannot do that, then try reading it out loud. 
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Module 6: Maintain Work Place Safety 

 
Objectives: After completing this module, the learner will be able to interpret safety rules/regulations, also expected to identify and use Personal 

Protective Equipment (PPE) according to the work place requirements. 

 

Learning Unit Learning Outcomes Learning Elements 
Materials 
Required 

LU1. Identify 

Hazards at 

Workplace 

Trainee will be able to: 

 Interpret work processes and procedures correctly to 

identify risk of hazards at workplace 

 Recognize processes, tools, equipment and 

consumable materials that have the potential to 

cause harm 

 Identify any potential hazards and take appropriate 

action to minimize the risk 

 Describe list of safety 

equipment in Working area 

 Follow safety signs and 

symbols 

 

  Multi media 

 Safety Tools 
 

LU2. Comply with 

Occupational 

Safety and 

Health (OSH) 

Trainee will be able to: 

 Complying with health and safety precautions. 

 Keep work area clean and clear of obstructions. 

 Store tools and equipment as per the procedure 

of industry to overcome any incident. 

 Remove personal articles (jewelry, watch, cell 

phone, etc.) 

 Describe Occupational Health 

and Safety. 

 Describe the procedure for 

keeping the Tools and 

equipment safe. 

 

 . Personal 
Protective 
Equipment 
(safety shoes, 
gloves, goggles, 
helmet & ear 
plug etc.) 

 OSH Manual 

LU3. Perform safe 

Work practices 

at workplace 

Trainee will be able to: 

 Follow industry workplace safety policy 

(rules/regulations). 

 Interpret safety workplace handbook. 

 Describe Work place safety 

regulations. 

 Define importance of safety 

Training/  

 Workplace 
safety hand 
book 
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 Repair equipment timely for avoiding damage or 

injuries 

 

LU4. Dispose of 

hazardous 

Waste/materials 

Trainee will be able to: 

 Identify hazardous waste need to be disposed 

off 

 Collect hazardous or non-hazardous waste 

carefully from the designated area as per 

approved procedure 

 Dispose-off hazardous waste as per procedure 

 Ensure masks and gloves while dispose-off 

hazardous waste as per standard operating 

procedure 

 

 Describe list of safety 

equipment in Work area 

 Follow safety signs and 

symbols 

 Explain different disposal 

techniques related to waste 

 Describe waste disposal 

SOPs 

 

 

 
. Fresh-air hose 
 
.Hazard signs 

LU5. Follow 

emergency 

procedures at 

work place 

Trainee will be able to: 

 Follow emergency plan 

 Communicate instructions to co workers 

 Assess risk and determine course of action 

 Operate emergency equipment and supplies 

 Describe various types of 

emergencies 

 Describe instructions to 

coworker concerning the 

emergency 

 Describe use of emergency 

equipment, supplies and their 

operation/procedure 

Maintenance box 
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Examples and illustrations 

 

Identifying workplace hazards 

Every workplace has hazards. As an employer, you have a legal responsibility to look after your employees’ safety and protect them against 
health and safety hazards at work. In order to manage workplace health and safety and help prevent accidents and sickness absence, it’s 
important to identify, monitor and reduce the risk associated with workplace hazards. 

 

What are workplace hazards? 

Workplace hazards are any aspect of work that cause health and safety risks and have the potential to harm. Some hazards are more likely to 
be present in some workplaces than others, and depending on the work that you do, there will be hazards that are more or less relevant to your 
business. 

 

What are the most common workplace hazards? 

There are many types of workplace hazards, which tend to come under four main categories: 

 physical hazards – the most common workplace hazards, including vibration, noise and slips, trips and falls; 

 ergonomic hazards – physical factors that harm the musculoskeletal system, such as repetitive movement, manual handling and poor 

body positioning; 

 chemical hazards – any hazardous substance that can cause harm to your employees; 

 biological hazards – bacteria and viruses that can cause health effects, such as hepatitis, HIV/AIDS and Legionnaire’s disease. 

 

Common health risks 

Some of the most common health risks associated with workplace hazards include: 

 breathing problems; 

 skin irritation; 

 damage to muscles, bones and joints; 

 hearing damage; 

 reduced wellbeing. 
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How to prevent workplace hazards? 

 

The best way to protect yourself and your employees from workplace hazards is to identify and manage them and take reasonable steps to 
prevent their potential to harm. 

In order to control workplace hazards and eliminate or reduce the risk, you should take the following steps: 

 identify the hazard by carrying out a workplace risk assessment; 

 determine how employees might be at risk; 

 evaluate the risks; 

 record and review hazards at least annually, or earlier if something changes. 

 

Elements of an Effective Safety Management System. 

There are so many aspects to creating and maintaining a safe working environment that sometimes it’s easy to get lost in it all. To truly succeed 
in creating a safe place of work, the key is to develop and implement an effective safety management system. 

A safety management system combines all the different elements in your workplace that need attention to ensure you provide a safe working 
environment for everyone who enters it. 

Safety management systems make health and safety an integral part of your business’s core operations. By designing, developing and 
implementing an effective safety management system, you will have methods for managing reporting, responsibilities, planning and resourcing 
to create a safer workplace. 

 

Safety management systems have six elements: 

 a safety plan; 

 policies, procedures and processes; 

 training and induction; 

 monitoring; 

 supervision; and 

 reporting. 
 
 

1. Safety plan 

A safety plan is a strategic action plan that forms part of the business plan. It analyses the current and prospective risk for a company and charts 
how the risks will be eradicated and controlled over a calendar period (the safety plan must have a budget). 

This plan will ensure that there is a governance structure within your company that ensures every worker clearly understands their safety 
obligations (and how to comply) and is accountable to carry out those obligations. 
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2. Policies, procedures and processes 

Policies, procedures and processes include all safety paper infrastructures within your company. This paperwork will describe all safety behaviour, 
expectations, record-keeping, incident reporting, and incident notification documentation. 

 

3. Training and induction 

Depending on the nature of your workplace (whether it is low-risk or high-risk), everyone who enters your workplace should receive training on: 

 the rules of your company; 

 the rules of the site; and 

 the rules of the location they are visiting. 

 

4. Monitoring 

Your obligations to monitor your workplace depend on circumstances and need. Always consider the level of risk. The higher the risk, the more 
frequent and detailed the monitoring needs to be. 

Other times when monitoring will be necessary include: 

 

 to ensure that all risk has been covered by a new risk assessment that has been carried out due to a change in process, e.g. the installation 
of new workstations; and 

 when an investigation takes place following an incident. 
 

5. Supervision 

The only way to ensure your workers are carrying out their safety obligations is to have adequate supervision. 

The level of supervision required in your workplace will increase if the level of safety control put in place to reduce a risk is low, i.e. the less 
effective the control measure used, the higher the level of supervision necessary. 

 

 

6. Reporting 

The governance structure of your company needs safety reporting at all levels, not just at board level. 

Your workers need to know what safety looks like – what’s going right and what’s going wrong. This can only occur when they receive safety 
feedback from you, e.g. how many hazards were identified, the risk levels associated with those hazards and what control measures were 
implemented. 

 

 



TLG Pine Nuts Processor- NVQF – Level - 2  Page | 26  

 

Five Steps of a Risk Assessment 

The Health and Safety Executive (HSE) advises employers to follow five steps when carrying out a workplace risk assessment: 

 

Step 1: Identify hazards, i.e. anything that may cause harm. 

Employers have a duty to assess the health and safety risks faced by their workers. Your employer must systematically check for possible 
physical, mental, chemical and biological hazards. 

This is one common classification of hazards: 

 Physical: e.g. lifting, awkward postures, slips and trips, noise, dust, machinery, computer equipment, etc. 
 

 Mental: e.g. excess workload, long hours, working with high-need clients, bullying, etc. These are also called 'psychosocial' hazards, 
affecting mental health and occurring within working relationships. 

 

 Chemical: e.g. asbestos, cleaning fluids, aerosols, etc. 
 

 Biological: including tuberculosis, hepatitis and other infectious diseases faced by healthcare workers, home care staff and other 
healthcare professionals. 
 
 

Step 2: Decide who may be harmed, and how. 

Identifying who is at risk starts with your organization’s own full- and part-time employees. Employers must also assess risks faced by agency 
and contract staff, visitors, clients and other members of the public on their premises. 

Employers must review work routines in all the different locations and situations where their staff are employed. For example: 

 

Employers have special duties towards the health and safety of young workers, disabled employees, night workers, shift workers, and pregnant 
or breastfeeding women. 

 

 

Step 3: Assess the risks and take action. 

This means employers must consider how likely it is that each hazard could cause harm. This will determine whether or not your employer should 
reduce the level of risk. Even after all precautions have been taken, some risk usually remains. Employers must decide for each remaining hazard 
whether the risk remains high, medium or low. 
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Step 4: Make a record of the findings. 

Employers with five or more staff are required to record in writing the main findings of the risk assessment. This record should include details of 
any hazards noted in the risk assessment, and action taken to reduce or eliminate risk. 

This record provides proof that the assessment was carried out, and is used as the basis for a later review of working practices. The risk 
assessment is a working document. You should be able to read it. It should not be locked away in a cupboard. 

 

Step 5: Review the risk assessment. 

A risk assessment must be kept under review in order to: 

 ensure that agreed safe working practices continue to be applied (e.g. that management's safety instructions are respected by supervisors 
and line managers); and 

 take account of any new working practices, new machinery or more demanding work targets. 
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Requirement for Safety Signs 

 

  

 

 

 

 

 

 

 

 

Safety colour Warning purpose Examples of use 

RED 

Stop   

 

Prohibition 

 

 

 

Fire-fighting 

Stop signs 

 

Identification, 

colour of emergency shut-down devices 

 

Showing fire hose, 

Ladder, emergency 

telephone 

fire extinguisher 

YELLOW 

Caution, risk 

of danger 

 

Identification of hazards 

(fire, explosion, chemical, radiation etc.) 

Warning signs 

Identification of thresholds 

Obstacles 

Risk of collision 

BLUE 
Mandatory action Obligation to wear PPE 

Mandatory signs 

GREEN 

Safe condition Identification of safety showers, 

First Aid points 

Emergency exits signs 
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   Safety Signs and Symbols 

                                                                      

https://suresafety.org/news/safety-signs-and-signals/ 

 

https://suresafety.org/news/safety-signs-and-signals/
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Module 7: Collect Pine Nut Cones from Trees 

 
Objectives: This Module covers the skills and knowledge required to Arrange Tools and equipment for cutting Pine nut cones, Adopt Health and 

Safety measures, select appropriate Cones for cutting, Cut Pine nut cones from trees and Sort Pine nut cones according to grades 

Learning Unit Learning Outcomes Learning Elements 
Materials 
Required 

LU1. Arrange Tools 

for cutting of 

Pine Nut Cones 

Trainee will be able to: 

 Identify the required tools and equipment for 

cutting Pine Nuts cones. 

 Secure the tools for safe carrying to the work 

place 

 Clean and Store the Tools and equipment after 

use. 

 Types of cutting tools 

 Use of tools 

 Suitability/appropriateness of tools 

 Sharpness techniques of tools. 

 Multi media 

 Cutting tools 

 Tools cleaning 
materials 

LU2. Adopt Health 

and safety 

measures 

Trainee will be able to: 

 Identify the hazardous at work place 

 Remove hazardous properly. 

 Wear the safety equipment accurately. 

 Ensure the work place is safe to wok.

 Knowledge of the required 

protective dress/ equipment. 

 Importance wear proper dress 

 Knowledge of cleaning 

materials and techniques 

 Multi media 

 Safety equipment 
 

LU3. Select 

appropriate 

cones for 

cutting. 

 

Trainee will be able to: 

 Identify the appropriate trees for cutting the 

cones. 

 Identify the appropriate cones for cutting. 

 Knowledge of appropriate trees 

 Knowledge of appropriate cones 

for cutting 

 Multi media 

 Safety equipment 
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LU4. Cut Pine nut 

cones from 

trees 

Trainee should be able to: 

• Wear proper Personal Protective 

Equipment (PPEs) for cutting of Pine nut 

cones. 

• Cut cones from Pine nut trees without 

damaging the immature cones (Next year). 

• Place Pine nut cones at appropriate point. 

 Knowledge of harvesting season. 

 Describe Cones maturity and color. 

 Knowledge of cutting techniques. 

 Identification of Male and Female 

cones. 

 Pine nut cones storage techniques. 

 Difference between healthy and 

infected cones. 

 Knowledge of Harms 

and its 

contamination 

 Health and safety 

 Multi media 

 Safety equipment 

 Cutting Tools 
 

LU5. Sort Pine nut 

cones 

according to 

grades 

Trainee must be able to: 

 Segregate Pine nut cones by sizes correctly. 

 Remove defective Pine nut cones. 

 Put the cones in bags. 

 Place Pine nut cones at dry place in a 

ventilated room / shelter 

 Describe various sizes of cones 

 Identification of defective pine nut 

cones 

 Proper use of bags for placing 

cones 

 Multi media 

 Safety equipment 

 Bags 
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Pine Nuts Production in South Waziristan  

South Waziristan is a mountainous area of North-Western part of Pakistan. It borders with Afghanistan and covers an area of approximately 

6,620 square kilometers. Waziristan is divided into two agencies for administrative purposes (South and North). It comprises the area west and 

south west of Peshawar between the Touchi River to the north and the Gomal River to the south. The Agency/District is divided into three 

administrative sub divisions: Sarwakai, Ladha and lower form of Wana. Main source of livelihood of South Waziristan’s residents is agriculture. 

Pine Nut (Chilghoza) is one of the main sources of income. In South Waziristan landscape of Pine forest covers the area from Shakai to Angoor 

Adda along the border of Afghanistan, where around 20% of the forest comprises of Pine trees. Main markets of SOUTH WAZIRISTAN pine nuts 

are Bannu, D.I.Khan, Peshawar, Rawalpindi and Lahore from where these are further supplied to other national and international markets. 

Waziristan produced around 5,000 tons of pine nuts annually. South Waziristan accounts for nearly 85-90% of the Pakistan’s pine nut produce. 

Since Pine nuts grows under special weather conditions and in specific region therefore regards as rear and precious commodity. Similarly, South 

Waziristan have a special weather conditions, hence these nuts are rear and famous around the globe for variety, quality taste and color. It is 

pertinent to mention that this sector and trade is unorganized in Waziristan.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



TLG Pine Nuts Processor- NVQF – Level - 2  Page | 33  

Cone Harvesting Time 

 

Cones of Chilgoza pine reach maturity in September and they should be collected before the outer scales open or loosen. At the time of maturity, 

cones first turn into green and then to brown colors. Cone collection begins in August and September and continues for two months. Both 

collection and preliminary processing (extraction) continue until February of the following year. In some areas, local harvesters collect the cones 

too early or sometimes too late, which results in low quality nuts. 

 

The harvesting season start in mid of August till the end of September every year. The harvesting of the pine cones is done manually. The tool 

used for cone harvesting is locally called “Nakash”. The men climb up the tree and harvest most of the cones (75-80%) in the first pick and the 

remaining 20-25% within two weeks’ time. Usually 15 persons are required in harvesting of 150 Kanal forests whereas twelve (12) persons (male) 

climb up the trees and harvest the cones while three (03) women assist them in collection of cones on the ground and filling of bags. The average 

yield per tree is 3-5 Kilogram. Growers do not use appropriate techniques to cut the cones from trees and to cut the cones from trees and 

resultantly considerable cone damage occur which affects the cone’s yield of next generation 

 

As the quality and price commanded for pine nuts are partially dependent upon harvesting cones at the correct stage of maturity, training 

harvesters on cone development and proper harvesting time can increase value for villagers, traders and exporters. Additional research on 

optimum harvesting time is recommended. 

 

Once cones are collected, they are generally transported to the village in large jute or burlap sacks and piled together. 
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Cone collection methods and tools 

 

Cones of pine trees are collected by climbing the tree with rope or ladder, ground-based, and/or through use of a tree-tong. Ground-based or use 

of a ladder does not harm the tree during cone collection, however climbing the tree with a rope or free climbing may damage branches. 

 
 
 

 
 

 
 
. 
 
 
 
 

 

 

 

 

 

 

Figure 1: a) Chilgoza pine cone removal hook,            
b) hook attached to pole                                             
and, c) cone collection with hook. 

1. Hook. 

In Pakistan, cones of chilgoza pine are commonly collected with a 

sharp hook attached to the end of a long stick (Figure 1) and in some 

areas, small axes are used as well. Local villagers and/or contractors 

use these hooks to detach cones from tree branches. Although these 

hooks ease cone collection, they can also be used to cut or break off 

the meristematic tips and ends of branches in order to down multiple 

cones. This type of incidental pruning can significantly impact seasonal 

growth patterns and affect the natural growth habit of the tree. The 

long-term effect of this type of harvesting on lifetime cone productivity 

is not well understood 
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2. Pole Pruner 

There is some alternative equipment that may increase time efficiency and reduce 

damages to branches during cone collection. Pole pruners (Figure 2) are designed to 

prune upper branches of trees. These can be used to prune pine cones from branches 

instead of breaking branches with common hooks. With this equipment cones can be 

pruned and detached from branches easily. Also, the efficiency of common hooks may 

be enhanced if another blade with a pulley is attached below the hook. Harvesting cones 

with pruners can decrease damages and injuries to the tree if used correctly, however 

they must be used with care as they are also capable of cutting off the tips and ends of 

branches. Modifications to traditional tree pruners have been suggested to reduce 

damage to trees. For example, it may be possible to sheath the cutting blades with a 

plastic cover or resin so that individual branches can be gripped and shaken to drop the 

cones as opposed to cutting. 

 

Figure 2   Cone removal with pole pruner. 
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Conclusions: 

Chilgoza pine play an important role in livelihood of local communities. People harvest pine cones and sell pine nuts in local and international 

markets. Mostly, cones are unsustainably collected by local villagers and or outside contractors. During cone collection trees are damaged and 

natural regeneration is suppressed. Use of traditional techniques and equipment is not very effective during cone collection. Most of the time, 

tree branches and bark is damaged with the use of locally made equipment. In order to avoid tree damage, cones have to be collected by trained 

individuals. In addition, use of better equipment such as pole pruners, tree tong, ladders and safety equipment can reduce tree damage. 

 

3. Tree Tong. 
Another tool that may have significant potential to reduce tree 
damage during harvesting is the Tree tong (Figure 3). This device 
attaches to the end of a long pole and plucks cones from the tree 
with a set of hands that are opened and closed by pulling on a cord 
attached to the tongs. Using the tree tong, no cutting or breaking 
of branches is incurred as individual cones are removed from the 
tree, or branches are shaken. While this tool has not been field 
tested in Pakistan, it is recommended that trial tests be conducted 
to determine its effectiveness compared with traditional methods. 

 
4. Climbing ladders  
Climbing Ladder can also enhance time and cone collection 
efficiency. If ladders are used carefully, cones of upper branches 
can be easily pruned without exerting any damage to the 
branches. Other protective equipment such as safety harnesses, 
ropes, gloves, helmets and goggles may also bring significant 
safety improvements for those climbing trees to collect cones. 

 Figure 3: a) Tree tong with cord for opening and closing;  

and, b) tree tong being used to remove pine cone from branch 
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Frequently Asked Questions 
 

1. What is Competency Based Training 
(CBT) and how is it different from 
currently offered trainings in 
institutes? 

Competency-based training (CBT) is an approach to vocational education and 
training that places emphasis on what a person can do in the workplace as a result 
of completing a program of training. Compared to conventional programs, the 
competency based training is not primarily content based; it rather focuses on the 
competence requirement of the envisaged job role. The whole qualification refers to 
certain industry standard criterion and is modularized in nature rather than being 
course oriented. 

2. What is the passing criterion for CBT 
certificate? 

You shall be required to be declared “Competent” in the summative assessment to 
attain the certificate. 

3. What are the entry requirements for 
this course? 

The entry requirement for this course is 8th Grade or equivalent.  

4. How can I progress in my 
educational career after attaining 
this certificate?  

You shall be eligible to take admission in the National Vocational Certificate Level-3 
in Pine Nuts Processor. You shall be able to progress further to National Vocational 
Certificate Level-4 in Pine Nuts Processor Course; and take admission in a level-5, 
DAE or equivalent course (if applicable). In certain case, you may be required to attain 
an equivalence certificate from The Inter Board Committee of Chairmen (IBCC). 

5. If I have the experience and skills 
mentioned in the competency 
standards, do I still need to attend 
the course to attain this certificate? 

You can opt to take part in the Recognition of Prior Learning (RPL) program by 
contacting the relevant training institute and getting assessed by providing the 
required evidences. 

6. What is the entry requirement for 
Recognition of Prior Learning 
program (RPL)? 

There is no general entry requirement. The institute shall assess you, identify your 
competence gaps and offer you courses to cover the gaps; after which you can take 
up the final assessment. 

7. Is there any age restriction for entry 
in this course or Recognition of Prior 
Learning program (RPL)? 

There are no age restrictions to enter this course or take up the Recognition of Prior 
Learning program 

8. What is the duration of this course? The duration of the course work is 1,510 hrs. (11 months) 
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9. What are the class timings? The classes are normally offered 25 days a month from 08:00am to 01:30pm. These 
may vary according to the practices of certain institutes. 

10. What is equivalence of this 
certificate with other qualifications? 

As per the national vocational qualifications framework, the level-4 certificate is 
equivalent to Matriculation. The equivalence certificate can be obtained from The 
Inter Board Committee of Chairmen (IBCC). 

11. What is the importance of this 
certificate in National and 
International job market? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
These standards are also recognized worldwide as all the standards are coded using 
international methodology and are accessible to the employers worldwide through 
NAVTTC website. 

12. Which jobs can I get after attaining 
this certificate? Are there job for this 
certificate in public sector as well? 

You shall be able to take up jobs in the local or overseas construction companies in 
heavy machinery operator job profile. 

13. What are possible career 
progressions in industry after 
attaining this certificate? 

You shall be able to progress up to the level of supervisor after attaining sufficient 
experience, knowledge and skills during the job. Attaining additional relevant 
qualifications may aid your career advancement to even higher levels. 

14. Is this certificate recognized by any 
competent authority in Pakistan? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
The official certificates shall be awarded by the relevant certificate awarding body. 

15. Is on-the-job training mandatory for 
this certificate? If yes, what is the 
duration of on-the-job training? 

On-the-job training is not a requirement for final / summative assessment of this 
certificate. However, taking up on-the-job training after or during the course work may 
add your chances to get a job afterwards. 

16. How much salary can I get on job 
after attaining this certificate? 

The minimum wages announced by the Government of Pakistan in 2019 are PKR 
17,500. This may vary in subsequent years and different regions of the country. 
Progressive employers may pay more than the mentioned amount. The heavy 
Machinery Operator normally earns 20,000 to 25,000 in the start.  

17. Are there any alternative certificates 
which I can take up? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field.  

18. What is the teaching language of this 
course? 

The leaching language of this course is Urdu and English. 
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19. Is it possible to switch to other 
certificate programs during the 
course? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field. 

20. What is the examination / 
assessment system in this program? 

Competency based assessments are organized by training institutes during the 
course which serve the purpose of assessing the progress and preparedness of each 
student. Final / summative assessments are organized by the relevant qualification 
awarding bodies at the end of the certificate program. You shall be required to be 
declared “Competent” in the summative assessment to attain the certificate. 

21. Does this certificate enable me to 
work as freelancer? 

You can start your small business by purchasing your own heavy construction 
machine and can start earning 50,000 per month. You may need additional skills on 
entrepreneurship to support your initiative. 

 

 




